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ВВЕДЕНИЕ 

 

Данные методические указания разработаны для студентов, обучающихся 

по направлению подготовки 11.03.01 «Радиотехника». 

Структура дисциплины «Цифровые устройства и микропроцессоры» 

предполагает выполнение студентами индивидуальной курсовой работы  

по проектированию системы управления технологическим процессом с учетом 

поступающих данных с множества датчиков состояний.  

В процессе изучения данной дисциплины на лекционных занятиях  

и в процессе выполнения лабораторных работ обеспечивается получение  

студентом основных знаний и навыков, необходимых для успешного выполне-

ния курсовой работы. 

Выполнение индивидуальных заданий курсовой работы призвано закре-

пить знания, умения и навыки, полученные в других частях дисциплины. 

Курсовая работа выполняется по единой тематике для группы одного  

года набора, но задания различаются индивидуальными вариантами для каж-

дого студента. 

В ходе выполнения курсовой работы студенты приобретают навыки про-

граммирования, работы с нормативно-технической документацией, разработки 

графических демонстрационных материалов, умения увязывать теоретические 

знания с практикой, четко излагать свои мысли, оформлять и представлять ре-

зультаты работы. 

Методические рекомендации подготовлены с целью помощи студентам  

в успешном выполнении индивидуальных заданий курсовой работы, предо-

ставляя необходимую информацию о требованиях к ее содержанию, этапах  

выполнения и защите. 
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1. ОБЩИЕ ПОЛОЖЕНИЯ 

 

Курсовая работа является неотъемлемой частью образовательного про-

цесса, важной формой самостоятельной учебно-исследовательской деятельно-

сти обучающихся. Она призвана углубить знания обучающихся по изучаемым 

дисциплинам, полученные ими в ходе учебных занятий, сформировать навыки 

самостоятельного изучения материала, исследовательской деятельности,  

а также научить обучающихся работать с различными источниками информа-

ции на бумажных и электронных носителях. 

Система курсовых работ, выполняемых обучающимися, является важной 

составляющей подготовки к выполнению выпускных квалификационных работ. 

Основной целью выполнения курсовой работы является развитие у обу-

чающихся профессиональных компетенций, применение полученных знаний, 

умений и навыков для решения конкретных профессиональных задач. 

Задачи курсовой работы: 

– углубление уровня и расширение объема профессионально значимых 

знаний, умений и навыков; 

– формирование умений и навыков самостоятельной организации учеб-

но-исследовательской работы; 

– формирование умения работать с нормативными и другими право-

выми актами, эмпирическим материалом, а также с учебной и научной литера-

турой; 

– овладение современными методами поиска и обработки информации  

и использования информационных ресурсов. 

Курсовая работа по дисциплине «Цифровые устройства и микропроцес-

соры» выполняется студентами по индивидуальным заданиям и служит для 

формирования у студентов навыков разработки программно-аппаратных систем 

управления технологическими процессами. 

Выполнение курсовой работы занимает значительную часть времени,  

отводимого на самостоятельную работу в соответствии с учебным планом  

по данной дисциплине. В связи с этим все необходимые материалы курсовой 
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работы подготавливаются студентом самостоятельно, в соответствии с методи-

ческими указаниями и рекомендациями преподавателя. Консультации, выдача 

заданий и прием результатов курсовой работы осуществляются только во время 

аудиторных занятий. 

Выдача задания на курсовую работу осуществляется в первые две недели 

после начала нового учебного семестра.  

Курсовая работа содержит ряд обязательных элементов, подлежащих раз-

работке. В течение семестра отдельные элементы курсовой работы, сформиро-

ванные студентом, предоставляются преподавателю для промежуточного кон-

троля. Замечания, сделанные преподавателем, подлежат обязательному исправ-

лению. На основании результатов промежуточного контроля преподаватель  

выставляет оценки в «Балльно-рейтинговой системе ТГТУ» студентам по кон-

трольным точкам, предусмотренным графиком учебного процесса. 

Материалы курсовой работы представляются на защиту в виде поясни-

тельной записки и устного сообщения, сопровождаемого демонстрационными 

материалами. 
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2. ПОРЯДОК ВЫПОЛНЕНИЯ КУРСОВОЙ РАБОТЫ 

 

Курсовая работа по дисциплине «Цифровые устройства и микропроцес-

соры» предполагает последовательное выполнение этапов: 

1. Заполнение индивидуального задания на курсовую работу. 

2. Постановка задачи.  

3. Разработка схемы электрической функциональной. 

4. Выбор решения поставленной задачи.  

5. Разработка и согласование технического задания. 

6. Конкретизация решения. Разработка схемы электрической принци-

пиальной или чертежа. 

7. Разработка алгоритма решения поставленной задачи. Разработка 

блок-схемы алгоритма. 

8. Разработка программного обеспечения для системы управления. 

9. Завершение работы. Оформление пояснительной записки. Предзащи-

та курсовой работы.  

10. Защита курсовой работы. 

Работа выполняется в течение одного семестра. Аудиторные занятия  

проходят не реже одного раза в неделю. Рекомендуемый график разработки  

и предоставления материалов по каждому из этапов представлен в табл. 1. 

 

Таблица 1 
 

Недели 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 

Этапы 

КР 
1 2 3 4 5 6 7 8 9 10 

 

Работу над этапом и оформление результатов студент осуществляет само-

стоятельно. Результаты выполнения этапа предъявляются преподавателю  

на последующих занятиях для промежуточного контроля. Преподаватель одоб-

ряет результаты этапа или отправляет на доработку с замечаниями. Не реко-

мендуется начинать очередной этап, не завершив итерацию предыдущего этапа. 
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Курсовая работа должна соответствовать следующим требованиям  

[1, с. 3]: 

 необходимый теоретический уровень выполнения; 

 наличие анализа не только теоретического, но и эмпирического мате-

риала; 

 использование в необходимых случаях результатов самостоятельного 

исследования; 

 установленный объем; 

 оформление в соответствии со Стандартом организации СТО ФГБОУ 

ВО «ТГТУ» 07–2017. Выпускные квалификационные работы и курсовые рабо-

ты (проекты). Общие требования. Актуальный вариант Стандарта всегда можно 

найти на сайте университета в разделе «Документы». 

Завершенная курсовая работа представляется на предзащиту по очной 

форме обучения не позднее, чем за одну неделю до начала экзаменационной 

сессии, в которой в соответствии с учебным планом предусмотрено выполне-

ние курсовой работы. 

  

https://www.tstu.ru/general/docum/pdf/standart/sto07-2017n.pdf
https://www.tstu.ru/general/docum/pdf/standart/sto07-2017n.pdf
https://www.tstu.ru/r.php?r=tgtu.general.docum.standart
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3. УТВЕРЖДЕНИЕ ТЕМЫ  

КУРСОВОЙ РАБОТЫ 

 

Рациональным подходом к выполнению любой курсовой работы  

или проекта является вариант, при котором тема и полученные данные  

в результате выполнения будут согласовываться с последующей темой выпуск-

ной квалификационной работой бакалавра. Рекомендуемые темы выпускных 

работ всегда можно посмотреть в рабочих программах, в разделе учебно-

методическая документация, в личном кабинете обучающегося. Если же тема 

студентом еще не выбрана, или есть другие варианты выпускной работы,  

которые не согласуются с выполнением данной курсовой, то студенту  

предлагается выбор тем из перечня рекомендуемых в рабочей программе  

дисциплины: 

1. Автоматический термошкаф на базе платформы Arduino (варианты  

индивидуальных заданий отличаются комбинациями датчиков и алгоритмом 

выполнения основного цикла). 

2. Домашняя метеостанция на базе платформы Arduino (варианты инди-

видуальных заданий отличаются комбинациями датчиков и алгоритмом выпол-

нения основного цикла). 

3. Разработка программируемых модулей системы «Умный дом» (вари-

анты индивидуальных заданий отличаются комбинациями датчиков и алгорит-

мом выполнения основного цикла). 

4. Автоматизированная теплица на микроконтроллере Atmega (варианты 

индивидуальных заданий отличаются комбинациями датчиков и алгоритмом 

выполнения основного цикла). 

5. Синтез комбинационных логических устройств (варианты индивиду-

альных заданий отличаются различными комбинациями логических элементов 

схемы) – данная тема рекомендуется исключительно студентам заочной или 

очно-заочной форме обучения. 
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Рекомендованные темы в процессе заполнения листа «Задание на курсо-

вую работу» конкретизируются для каждого студента индивидуально в соот-

ветствии с вариантом задания. 

Количество и тип датчиков, состав исполнительных элементов, пределы  

и режимы регулирования должны быть согласованы с преподавателем. 

После утверждения листа задания заведующим кафедрой смена темы  

и варианта задания курсовой работы не допускается. 
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4. СОДЕРЖАНИЕ ИНДИВИДУАЛЬНОГО ЗАДАНИЯ 

 

Индивидуальное задание формируется после выбора темы курсовой  

работы. Лист задания заполняется студентом и представляется на утверждение 

преподавателю, а затем заведующему кафедрой. После утверждения задание 

принимается к исполнению студентом.  

Индивидуальное задание по курсовой работе включает следующую  

информацию: 

1) тема курсовой работы по дисциплине «Цифровые устройства  

и микропроцессоры»; 

2) цель курсовой работы, в которой необходимо отразить не только про-

ектирование системы управления технологическим процессом, но и закрепле-

ние знаний и навыков, полученных в процессе обучения, а также формирование 

компетенций, предусмотренных рабочей программой дисциплины; 

3) задачи курсовой работы, которые складываются из следующих реко-

мендуемых пунктов: 

 разработка и анализ технического задания; 

 разработка функциональной схемы автоматической системы управ-

ления; 

 разработка структурной схемы автоматической системы управления; 

 разработка принципиальной схемы автоматической системы управ-

ления; 

 разработка блок-схемы алгоритма управления; 

 разработка и отладка управляющей программы; 

 разработка аннотации и оформление пояснительной записки;  

 предзащита и защита курсовой работы. 
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5. СТРУКТУРА ПОЯСНИТЕЛЬНОЙ ЗАПИСКИ К КУРСОВОЙ РАБОТЕ 

 

Пояснительная записка к курсовой работе должна содержать следующие 

элементы: 

1. Титульный лист. Шаблон титульного листа можно найти на официаль-

ном сайте университета, в разделе нормативные документы в СТО ФГБОУ ВО 

«ТГТУ» 07–2017. 

2. Лист задания. Шаблон листа задания можно найти на официальном 

сайте университета, в разделе нормативные документы в СТО ФГБОУ ВО 

«ТГТУ» 07–2017. 

3. Аннотация. 

4. Содержание. 

5. Введение.  

6. Анализ технического задания. 

7. Функциональная схема автоматической системы управления. 

8. Структурная схема автоматической системы управления. 

9. Принципиальная схема автоматической системы управления. 

10. Блок-схема алгоритма управления. 

11. Разработка и отладка управляющей программы. 

12. Заключение. 

13. Список использованных источников. 

14. Приложение. 

Каждый элемент должен начинаться с новой страницы. 

В таблице 2 показаны структура и последовательность размещения мате-

риала пояснительной записки курсовой работы, краткое содержание каждой 

структурной части и рекомендуемый объем в страницах рукописного текста. 

В целом пояснительная записка должна отображать умение студента  

сжато, логично и аргументировано излагать материал, а ее оформление должно 

соответствовать требованиям ЕСКД. При написании записки студент обязан 

давать ссылки на автора и источник, откуда он заимствует материал или  

отдельные результаты/ 

https://www.tstu.ru/r.php?r=tgtu.general.docum.standart
https://www.tstu.ru/r.php?r=tgtu.general.docum.standart
https://www.tstu.ru/r.php?r=tgtu.general.docum.standart
https://www.tstu.ru/r.php?r=tgtu.general.docum.standart
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Таблица 2  
 

Структурная 

часть 
Требования к содержанию Объем 

Титульный лист Пример заполнения титульного листа ПЗ курсовой 

работы приведен в приложении А [5] 

1 

Задание  

на курсовую  

работу 

Приводится задание на курсовую работу  

для конкретного варианта, пример заполнения  

в приложении Б [5] 

2 

Введение Приводится оценка современного состояния  

решаемой в работе задачи 

1–2 

Аннотация Аннотация является заключительным этапом  

над работой. Она должна содержать общие сведе-

ния и краткую характеристику работы: название 

темы, фамилию студента и руководителя работы, 

год защиты, краткие характеристики важнейших 

материалов, оборудования, конструкций, приве-

денные в основных разделах работы 

1 

Содержание Указываются обозначения и наименования всех 

разделов, подразделов, пунктов и номера страниц, 

на которых размещается начало материала  

2–3 

Основная часть Наименование разделов основной части, их коли-

чество и содержание определяются студентом  

индивидуально исходя из рекомендаций и полу-

ченного задания. В них описываются теоретиче-

ские положения работы, используемые методы, 

приводятся результаты теоретических расчетов, 

экспериментальных исследований, дается их  

анализ и делаются выводы 

20 – 

30 

Заключение Приводятся краткие выводы о результатах выпол-

ненной работы, оформленные в виде абзацев 

1–2 

Библиографиче-

ский список 

Список составляется в соответствии  

с ГОСТ 7.1–84 

1–2 

Приложение 1 В приложение выносятся материалы, поясняющие 

основное содержание работы, громоздкие выклад-

ки и доказательства, таблицы, рисунки, программ-

ная документация 

– 

Приложение 2 Для каждого приложения обязательным является 

содержательное наименование, которое пишется 

после его номера 

– 
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6. ТРЕБОВАНИЯ К ЭЛЕМЕНТАМ КУРСОВОЙ РАБОТЫ 

 

Текст пояснительной записки оформляется в текстовом редакторе в стро-

гом соответствии с СТО ФГБОУ ВО «ТГТУ» 07–2017. Оформление схем  

осуществляется в рекомендуемом графическом редакторе, либо в любом  

доступном, с последующим переводом в формат «.pdf». 

Представление преподавателю схем выполненных от руки допускается 

только на этапе согласования и текущего выполнения пунктов курсовой работы. 

Нельзя использовать цветные линии, заливки и шрифты, так как итоговое пред-

ставление и последующая печать работы предполагаются в «оттенках серого».  

Требования к отдельным элементам 

1. Титульный лист обязательно должен быть подписан студентом. Дата 

подписи должна соответствовать завершению последней итерации пояснитель-

ной записки, одобренной преподавателем и допущенной к защите. Если работа 

сдается в электронном виде, то даты и подписи проставляются в соответству-

ющих таблицах информационно-удостоверяющих листов. 

2. Лист задания должен быть подписан преподавателем и студентом. Дата 

подписи должна соответствовать первым двум неделям семестра, в котором 

выполняется курсовая работа. Если работа сдается в электронном виде, то даты 

и подписи проставляются в соответствующих таблицах информационно-

удостоверяющих листов. 

3. Содержание рекомендуется формировать автоматически применяемым 

текстовым редактором. При формировании электронной копии документа  

в формате «.pdf» рекомендуется обновить номера страниц в оглавлении. 

4. Во введении должна быть обоснована актуальность выбранной темы, 

указаны цель и задачи работы в соответствии с утвержденным заданием. 

5. Функциональная схема автоматической системы управления должна 

отвечать на вопрос, для чего используется разрабатываемая система. Схема 

предполагает выявление входных и выходных информационных, материальных 

или энергетических потоков создаваемой системы без привязки к объектам 

внешнего мира. В данном случае предполагается, что система преобразует  

https://www.tstu.ru/r.php?r=tgtu.general.docum.standart
https://www.tstu.ru/general/docum/doc/standart/ul.doc
https://www.tstu.ru/general/docum/doc/standart/ul.doc
https://www.tstu.ru/general/docum/doc/standart/ul.doc
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входы в выходы. Все основные функциональные узлы системы управления 

обозначаются схематически как прямоугольник. Все входы и выходы информа-

ционных сигналов обозначаются стрелками вправо и влево. Управляющие  

входы дополнительно могут быть указаны стрелками сверху, ресурсные – 

стрелками снизу. Каждый отдельный вход или выход обозначается индивиду-

альной стрелкой. Каждая стрелка на функциональной схеме подписывается  

соответствующим образом. Надпись не должна пересекаться стрелкой.  

Все надписи размещаются справа или вверху от стрелки, при этом ближайшее 

расстояние от линии стрелки до текста надписи не должно превышать высоты 

буквы надписи. Пример функциональной схемы представлен на рис. 1. 

 

 
 

Рис. 1. Пример функциональной схемы системы управления 

 

6. Структурная схема автоматической системы управления отображает 

внутреннее устройство системы управления и должна полностью соответство-

вать функциональной схеме. Структурная схема должна содержать не менее 

двух подсистем или элементов. Подсистемы или элементы изображаются  

схематически простейшими геометрическими фигурами (прямоугольник,  

овал и т.п.) и обязательно подписываются. Подпись должна помещаться внутри 

фигуры и не выходить за ее края. 
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Допускается иерархическая группировка элементов в подсистемы путем 

изображения элементов внутри подсистем. Стрелками указываются информа-

ционные, материальные или энергетические потоки между отдельными функ-

циональными узлами системы управления. Стрелками обозначается также  

и связи с внешними объектами, которые на схеме отсутствуют. Надписи для 

стрелок рекомендуется размещать справа или вверху. Ближайшее расстояние  

от линии стрелки до текста надписи не должно превышать высоты буквы  

надписи. Если между подсистемами осуществляется двунаправленный обмен 

потоками, то применяются двунаправленные стрелки или две отдельные,  

обозначающие соответственное направление потоков. Пример структурной 

схемы приведен на рис. 2. 

 

 

Рисунок 2 – Структурная схема системы управления 

 

7. Техническое задание на курсовую работу разрабатывается в соответ-

ствиями с рекомендациями, представленными в ГОСТ 34.602–2020. 

Техническое задание должно включать все разделы, представленные  

в ГОСТе. В частности, необходимо обратить внимание на раздел 4 «Требования 

к системе», который должен состоять из четырех обязательных подразделов: 

 требования к системе в целом; 

 требования к функциям (задачам) системы; 

 требования к видам обеспечения; 

 общие технические требования. 

https://www.swrit.ru/doc/gost34/34.602-2020.pdf
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Из большого числа требований, представленных в ГОСТе, необходимо 

указать только наиболее значимые для курсовой работы, остальные можно опу-

стить. 

8. Принципиальные схемы оформляются в соответствии с ГОСТ 2.702–

2011. Если в курсовой работе применяются готовые отладочные платы или 

функционально законченные модули в виде печатных плат, то они отобража-

ются на схеме в виде прямоугольников с маркировкой в верхней части и нуме-

рацией/обозначением выводов. Пример оформления схемы устройства управ-

ления приведен ниже. 

 

 

Рис. 3. Схема электрическая принципиальная микропроцессорной системы управления 

 

Чертежи курсовой работы оформляются в строгом соответствии с указа-

ниями, представленными в ГОСТ 2.109–73. 

9. Блок-схема алгоритма управления процессами. Структура блок-

схем, а также содержание записей, помещаемых внутри блоков или рядом  

с ними, не регламентируется. Но при этом необходимо придерживаться следу-

ющих правил и рекомендаций (ГОСТ 19.002–80): 

https://docs.cntd.ru/document/1200086241
https://docs.cntd.ru/document/1200086241
https://docs.cntd.ru/document/1200001992
https://www.swrit.ru/doc/espd/19.003-80.pdf
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1) записи в блок-схемах должны быть ясными и однозначно определять, 

какой этап решения задачи данный блок отражает; 

2) номер блока ставится слева вверху в разрыве контура символа; 

3) нормативным направлением линий считается направление сверху вниз 

и слева направо. 

 

3. Правила построения алгоритма выполнения программы 

 

Наименование 

Обозначение и размеры 

(a/b = 1/1,5, где a – ширина, 

b – длина) 

Функция 

1. Процесс 

 

Выполнение операции (группы 

операций), в результате которой 

изменяются значение, форма 

представления или расположение 

данных 

2. Ввод-вывод 

 

Преобразование данных в форму, 

пригодную для обработки (ввод), 

или отображение результатов об-

работки (вывод) 

3. Решение 

 

Выбор направлений выполнения 

алгоритма или программы  

в зависимости от некоторых  

переменных условий 

4. Пуск-

остановка 

 

Начало, конец, прерывание  

процесса обработки данных  

или выполнения программы 

5. Соединитель 

 

Указание связи между прерван-

ными линиями потока, связыва-

ющими символы 

 

Линии потока проводятся только по вертикали и горизонтали и подво-

дятся к осевым линиям символов. Для линий, связывающих два элемента блок-

схемы, допускается не более трех операторов. 
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Линии потока можно прерывать. Для указания связи между прерывания-

ми используется символ «соединитель». 

Алгоритм функционирования системы управления представлен на рис. 4. 

 

 

Рис. 4. Блок схема алгоритма 

 

10. Разработка и отладка управляющей программы. В качестве основного 

контроллера для системы управления рекомендуется выбирать микроконтрол-

леры ATmega. Данная серия дает несколько преимуществ. Во-первых, вся  

документация на данные контроллеры хранится в открытом доступе на офици-

альном сайте компании-производителя. Во-вторых, документация по настройке 

и использованию микроконтроллеров имеет русскоязычный перевод,  

и в третьих, для данной серии микроконтроллеров доступны бесплатные версии  

программных продуктов по разработке и отладке микропрограмм. Одна  

из наиболее простых программ для освоения микроконтроллеров ATmega –  
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это среда разработки ArduinoIDE, которая работает как в связке с платформой 

Arduino или ее аналогами, так и есть возможность загружать микропрограмму 

сразу в микроконтроллер. 

Рассмотрим подробнее особенности работы в среде ArduinoIDE. 

 

 

Рис. 5. Cреда разработки ArduinoIDE 
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Среда разработки ArduinoIDE представляется пользователю в простом 

интерфейсе, состоящем из нескольких основных областей: области встроенного 

текстового редактора для программного кода, области для вывода сообщений 

по компиляции и загрузке кода в микроконтроллер, окна вывода текста (консо-

ли), области, отводимой для панели инструментов с кнопками часто используе-

мых команд и выпадающего меню. Для выгрузки микропрограмм и связи  

с микроконтроллером необходимо подключить среду разработки к аппаратной 

части Arduino или непосредственно к микроконтроллеру через программатор.  

Микропрограмма, написанная в среде ArduinoIDE, называется «скетч». 

Скетч пишется в области текстового редактора, который имеет инструменты 

вырезки/вставки, поиска/замены текста. Во время сохранения и экспорта проек-

та в области сообщений могут появляться пояснения или ошибки загрузки  

и экспорта. Текстовое окно внизу отображает сообщения среды ArduinoIDE,  

в том числе полные отчеты об ошибках, и другую информацию, вывод которой 

настраивается в меню настроек интерфейса. С помощью кнопок на панели  

инструментов можно проверять и загружать микропрограмму либо создавать, 

открывать и сохранять микропрограмму, открывать окно для работы с последо-

вательной шиной.  

Внешний интерфейс, состав кнопок и перечень дополнительных опций 

немного отличается при использовании различных версий ArduinoIDE.  

Подробное описание и возможности среды всегда можно посмотреть на офици-

альном сайте разработчиков платформы – https://www.arduino.cc/ или русско-

язычном сайте – https://arduino.ru/  

 

 

Загрузка программы на платформу Arduino или прошивка. 

 

Перед загрузкой программы необходимо через меню Tools > Board  

выбрать имеющийся тип платформы, для которого написана программа, а далее 

в меню Tools > Serial Port выбрать соответствующий COM-порт, к которому 

подключена плата. При работе на компьютере под управлением Windows порты 

обозначаются как COM4, COM5, COM7 и выше. Правильно определить, какому 

https://www.arduino.cc/
https://arduino.ru/
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порту соответствует подключенная плата, можно в «Диспетчере устройств»  

в пункте Последовательной шины USB. При использовании ОС Linux порты 

обозначаются как /dev/ttyUSB0, /dev/ttyUSB1.  

Далее, когда правильно выбран порт, можно загрузить нашу программу  

в микроконтроллер или на платформу. Для этого выбрать пункт меню  

File > Upload to I/O Board или кнопку «Вгрузить». При использовании неориги-

нальных и старых версий платформ Arduino необходимо выбирать в меню 

Tools > Board платы с надписью «Old Bootloader». На большинстве плат 

Arduino во время загрузки программы будут моргать одновременно светодиоды 

передачи данных RX и TX. В конце компиляции и загрузки программы среда 

ArduinoIDE выведет в нижнем текстовом окне сообщение об успешной загрузке 

или об ошибках компиляции/загрузки.  

В случае успешной компиляции и загрузки программы на плату (в микро-

контроллер) сразу начинается ее выполнение. 

 

 

 

Библиотеки 

 

Использование библиотек при написании программы позволяет значи-

тельно сократить время ее разработки и повысить функциональность програм-

мам при работе с аппаратной частью или при обработке данных. Для подклю-

чения библиотек необходимо воспользоваться пунктом меню Sketch > Import 

Library, после чего в начале текста программы появится директива #include. 

Включение в основной код программы библиотек требует дополнительной  

памяти микроконтроллера, поэтому неиспользуемые библиотеки желательно 

убирать удалив лишнюю директиву #include. 

На https://www.arduino.cc/ и https://github.com/ имеется множество  

библиотек под различные задачи. Каждая библиотека, как правило, содержит 

примеры программ ее использования, которые становятся доступны после ее 

установки через меню File > Examples (Файл > Примеры). Изначально некото-

рые часто используемые библиотеки уже включены в среду ArduinoIDE. Другие 

могут быть загружены с различных ресурсов.  

https://www.arduino.cc/
https://github.com/desktop
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Мониторинг последовательного порта (Serial Monitor) 

 

Для просмотра данных при выполнении программы платформой Arduino 

можно использовать монитор последовательного порта, который доступен  

через меню Tools (Инструменты). В окне монитора отображаются данные,  

посылаемые в платформу Arduino или принимаемые с нее. Для правильной  

работы монитора порта предварительно необходимо настроить скорость пере-

дачи из выпадающего списка. Скорость должна соответствовать значению 

Serial.begin в загруженной программе. При запуске окна монитора порта  

он сразу начинает принимать данные с шины, а для отправки данных в порт  

необходимо ввести текст и нажать кнопку Send или Enter. Для более сложных 

решений можно осуществлять обмен информацией с платформой через специа-

лизированные программы, например Processing, Flash, MaxMSP. 

11. Заключение. Заключение представляет собой краткий обзор резуль-

татов, полученных в процессе выполнения курсовой работы, и сделанных  

на их основе самостоятельных аналитических выводов. 

Содержание заключения составляют: 

 важнейшие выводы по теоретическим и практическим аспектам про-

блемы, к которым в процессе написания работы пришел автор; 

 итоговая оценка проведенного исследования, проектирования с крат-

ким описанием его результатов; 

 основные положения, отличающие данную работу (проект) от работ 

предшественников; 

 предложения, которые могут быть внедрены в практическую деятель-

ность, и преимущества, связанные с реализацией этих предложений; 

 мнение относительно перспектив дальнейших исследований по разра-

батываемой теме; 

 подведение общих итогов (решены ли поставленные задачи, достиг-

нуты ли поставленные цели). 

Объем заключения, как правило, составляет не более одной страницы. 
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12. Список использованных источников. Оформление списка использо-

ванных источников должно соответствовать ГОСТ 7.1, ГОСТ 7.82. В тексте 

курсовой работы на все источники должны быть ссылки по ГОСТ Р 7.05.  

Сведения об источниках в списке использованных источников следует распола-

гать в алфавитном, систематическом, хронологическом или нумерационном  

порядке. В курсовой работе применяется только один из этих способов. Список 

использованных источников нумеруется арабскими цифрами с точкой. В состав 

библиографического описания входят области описания в соответствии с п. 4.4 

ГОСТ 7.1, для курсовых работ в области описания источников информации до-

пускается применять только обязательную составляющую, которая содержит 

библиографические сведения, обеспечивающие идентификацию документа. 

13. Приложение. Материал, дополняющий текст курсовой работы, допус-

кается помещать в приложениях. Приложениями могут быть, например: графи-

ческий материал (структурная, функциональная и принципиальная схемы),  

алгоритм функционирования системы управления и программа для микро-

контроллера. 

Приложения оформляют как продолжение документа на последующих 

листах или в виде самостоятельного документа, а в тексте курсовой работы  

на все приложения обязательно должны быть ссылки. Степень обязательности 

приложений при ссылках не указывается. Приложения располагают в порядке 

ссылок на них в тексте и обозначаются заглавными буквами русского алфавита, 

начиная с А (кроме букв Ё, З, Й, О, Ч, Ь, Ы, Ъ). 

Каждое приложение следует начинать с новой страницы с указанием  

наверху посередине страницы слова «ПРИЛОЖЕНИЕ» и его обозначения,  

а под ним в скобках – характер приложения (обязательное, рекомендуемое, 

справочное). 

Приложение должно иметь заголовок, который размещают симметрично 

относительно текста с прописной буквы отдельной строкой. 

Все приложения должны быть перечислены в содержании документа  

с указанием их обозначений и заголовков. 
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7. ОЦЕНИВАНИЕ КУРСОВОЙ РАБОТЫ 

 

Оценка курсовой работы выставляется по совокупности оценок качества 

представленных материалов в течение семестра, на предзащите и на защите. 

При оценивании материалов учитывается: 

 полнота текстового описания и обоснования схем; 

 выполнение всех требований, изложенных в п. 6 настоящих методиче-

ских указаний; 

 качество ответов на вопросы в процессе защиты. 

Основанием для снижения оценки является также: 

 наличие грамматических ошибок; 

 недочеты по оформлению текста пояснительной записки; 

 систематическое невыполнение рекомендаций преподавателя; 

 несоблюдение сроков сдачи отдельных элементов и курсовой работы 

в целом. 
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8. ЗАЩИТА КУРСОВОЙ РАБОТЫ 

 

Защита производится публично. На защите присутствуют, как правило, 

все студенты группы. При защите курсовой работы могут присутствовать заве-

дующий кафедрой и другие преподаватели. 

Защита курсовой работы включает краткий доклад студента (не более  

5 минут), ответы на вопросы, поставленные преподавателем по предмету рабо-

ты. Доклад студента может сопровождаться демонстрационными материалами, 

в которые выносятся основные элементы (не более 7 слайдов). 

Структура доклада: 

– тема курсовой работы, ее цель; 

– формулировка проблемы, описание технического задания; 

– методы решения поставленных задач, результаты работы; 

– предложения и выводы по работе. 

При защите курсовой работы студент должен обосновать свои выводы  

по избранной теме, ответить на замечания преподавателя, а также на уточняю-

щие и дополнительные вопросы, возникшие при защите. 
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9. ВЫПОЛНЕНИЕ И СДАЧА НА ХРАНЕНИЕ КУРСОВОЙ РАБОТЫ  

В ЭЛЕКТРОННОЙ ФОРМЕ 

 

В соответствии с локальными нормативными актами ФГБОУ ВО «ТГТУ» 

курсовая работа выполняется в виде электронного документа (ДЭ), подлинник 

работы сохраняется на оптическом диске (СD-R или DVD-R). 

Работа как основной электронный документ включает в себя все элек-

тронные и неэлектронные документы (например, титульный лист, лист задания, 

пояснительную записку, приложения, чертежи). 

Электронный документ выполняют на стадии разработки курсовой рабо-

ты и применяют на всех последующих стадиях. 

При выполнении электронного документа следует использовать только 

программное обеспечение, которое рекомендовано выпускающей кафедрой  

и руководителем курсовой работы. 

Любой электронный документ состоит из двух частей: содержательной  

и реквизитной. Содержательная часть включает необходимую информацию  

о документе и может составляться как отдельными документами или в любом 

сочетании из текстовой, графической, мультимедийной информации. 

Реквизитная часть каждого электронного документа состоит из информа-

ционно-удостоверяющих листов (УЛ) – сопроводительного бумажного  

документа с собственноручными подписями в нем, предназначенного  

для идентификации и авторизации документа (курсовой работы). 

Информационно-удостоверяющие листы следует выполнять на листах 

формата А4 по ГОСТ 2.301 по форме, приведенной в приложении Ж1 СТО 

ФГБОУ ВО «ТГТУ» 07–2017. 

В графе 1 указывается порядковый номер документа. Рекомендуется  

следующий порядок документов:  

1) лист задания;  

2) титульный лист;  

3) ведомость проекта;  

https://www.tstu.ru/general/docum/pdf/standart/sto07-2017n.pdf
https://www.tstu.ru/general/docum/pdf/standart/sto07-2017n.pdf
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4) пояснительная записка;  

5) графические документы (чертежи, схемы и т.п.). 

В графе 2 указывается обозначение работы как основного документа. 

Пример – ТГТУ.11.03.01.025 КР ДЭ 

В графе 3 указывается вид и тема курсовой работы. 

Пример – курсовая работа «Синтез комбинационных логических  

устройств». 

В графах 4, 5 указываются обозначение, наименование и вид документа, 

для сопровождения которого используется данный УЛ. 

Пример – Графа 4 – «ТГТУ.11.03.01.025 КР 2D-Э3»; графа 5 –  

«Устройство управления микроклиматом теплицы. Схема электрическая  

принципиальная». 

Графы 6–7 предназначены для указания реквизитов (кроме реквизитов, 

значениями которых являются подписи), характерных для данного конкретного 

вида документа. 

В графе 6 указывается наименование реквизита. 

В графе 7 указывается значение реквизита. 

Устанавливается следующая номенклатура обязательных дополнитель-

ных реквизитов для граф 6-7: 

– титульный лист: «кафедра», «группа»; 

– лист задания: «срок представления к защите». 

При необходимости в документы и, соответственно, в УЛ могут быть  

добавлены и другие реквизиты. 

Графы 8 – 11 предназначены для указания реквизитов, значениями кото-

рых являются подписи, характерные для данного конкретного вида документа. 

В графе 8 указывается характер работы, выполняемой лицом, подписав-

шим документ («Автор», «Разработал», «Задание принял к исполнению»,  

«Руководитель», «Проверил», «Консультант», «Нормоконтролер», «Нормокон-

троль», «Утверждаю», «Утвердил», «Согласовано» и т.п.). 
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В графах 9 – 11 проставляются Ф.И.О., подпись лица, подписавшего  

документ, и дата подписания соответственно. 

Перечень реквизитов, указываемых в графах 8 – 11, определяется формой 

соответствующего документа. 

В графе 12 указывается обозначение УЛ. 

Пример – ТГТУ.11.03.01.025 КР УЛ 

В графах 13, 14 указываются номер текущей страницы и общее количе-

ство страниц в УЛ соответственно. 

Количество строк для заполнения граф 6–7, 8 – 11 может быть при необ-

ходимости изменено как в сторону увеличения, так и в сторону уменьшения. 

Допускается на одной странице УЛ оформлять два документа.  

Пример такого оформления приведен в приложении Ж2 СТО ФГБОУ ВО 

«ТГТУ» 07–2017. 

Структура записи курсовой работы на оптическом диске. 

В корневой папке оптического диска должна быть только одна основная 

папка с обозначением работы, фамилией, инициалами автора. 

Пример – ТГТУ.11.03.01.025 КР ДЭ Иванов И.И. 

Содержательная часть каждого ДЭ в виде одного или нескольких файлов 

должна быть размещена внутри основной папки. Формат файлов устанавлива-

ется выпускающей кафедрой. 

Имя каждого файла в основной папке должно состоять из обозначения 

ДЭ и краткого наименования файла. 

Примеры 

ТГТУ.11.03.01.025 КР ТЭ-ЗД Задание.doc 

ТГТУ.11.03.01.025 КР ТЭ-ТЛ Титульный лист.doc 

ТГТУ.11.03.01.025 КР ТЭ-ПЗ Пояснительная записка.doc 

ТГТУ.11.03.01.025 КР 2D-Э3 Схема эл. принцип.dwg 

Допускается оформлять текстовую часть работы в виде одного файла 

(включая титульный лист, лист задания, приложения), имя которого представ-

ляет собой обозначение работы. 

Пример – ТГТУ 11.03.01.025 КР ДЭ.doc 

https://www.tstu.ru/general/docum/pdf/standart/sto07-2017n.pdf
https://www.tstu.ru/general/docum/pdf/standart/sto07-2017n.pdf
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Сдача работ на хранение 

 

После защиты курсовая работа сдается на хранение на выпускающую  

кафедру в конверте формата С4 (рекомендуется) или С5 (по ГОСТ Р 51506)  

с этикеткой 100х65 мм (приложение И СТО ФГБОУ ВО «ТГТУ» 07–2017).  

При этом оформляется перечень документов, сдаваемых на хранение  

(приложение К СТО ФГБОУ ВО «ТГТУ» 07–2017). 

В перечень документов, сдаваемых на хранение, входят: 

 подлинник курсовой работы на оптическом диске (на диск должно 

быть нанесено обозначение работы и должны стоять подписи нормоконтролера 

и автора работы); 

 информационно-удостоверяющий лист. 

По решению выпускающей кафедры в данный перечень могут быть 

включены и другие документы. 

 

  

https://www.tstu.ru/general/docum/pdf/standart/sto07-2017n.pdf
https://www.tstu.ru/general/docum/pdf/standart/sto07-2017n.pdf
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